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Software Mendeley

Mendeley adalah software atau program aplikasi
vang dikembangkan oleh Elsevier dalam
mempermudah melakukan integrasi sitasi dan
referensi pada suatu dokumen.



Langkah Pertama (1)
Download Software Mendeley melalui alamat url berikut :
https://www.mendeley.com/download-desktop/

- Download Mendeley Desktop for Windows

N\

Dowerload Menddey Desktop for Windeows



Langkah Kedua (2)
Membuat Akun Mendeley

Untuk membuat akun mendeley, silahkan kembali mengakses situs
www.mendeley.com kemudian Klik “Create Account” untuk memulai
proses membuat akun Mendeley. Akun Mendeley juga dapat dibuat

menggunakan akun facebook yang Anda miliki.

| 7. BREAKTHROUGHS

Mendeley brings your research to life, so you can make an impact on tomorrow

Sign Up For Free




Masukkan alamat email yang valid, kemudian klik
Continue

ELSEVIER

Sign in

Enter your email to continue with Mendeley

1

You can also sign in via your institution, organization or Athens.




Lanjutkan dengan melengkapi form nama lengkap seperti contoh
pada gambar berikut ini:

N ELSEVIER

Register

Create password to register
hari.aspriyo
Given name Family name
Hari Aspriyono
Password
........
[] Stay signed in (not recommended for shared devices

By continuing you agree with our Terms and conditions and Privacy

policy.

| already have an account




Klik Register, kemudian lanjutkan dengan mengklik Continue to
Mendeley, seperti pada contoh gambar berikut ini:

ELSEVIER

You are registered

You can now sign in to all Elsevier products with these details.

Continue to Mendeley




Selanjutnya lengkapi form Status dan Bidang Keilmuan kemudian
klik Continue to Mendeley, seperti contoh di bawah ini:

Welcome to Mendeley

Tell us more about yourself so we can serve you better.

G
-

Lecturer

Computer Science

B Make profile public &)

Mendeley Ltd. may email you information about our products,
services and events. You can update your communication

preferences settings any time via our email notification centrg

Continue to Mendeley

Skip this step




Langkah Ketiga (3)

Setelah software mendeley didownload dan sudah membuat akun di
mendeley, selanjutnya install mendeley dengan meng-klik 2x file
installer mendeley yang telah didownload "Mendeley-Desktop-1.19.1-
win32.exe" sehingga Setup Wizard akan mengarahkan kita untuk

menyelesaikan proses instalasi Mendeley Desktop.
124 |dk-10.0.2_windows-464_bin 04/09/ 20016819 App

HMendEIEj,r-Deslctnp-l.lFJ.l-winﬂ ’ 10/08/20081919  App
ﬂ NOP46Z2-KEILO1800-u80-16d-ANOS-ENU OB/0G/200660:28  App
|, netbeans-B.2-javase-windows x 04/09/20088:20  App

jcation 39614 K
jcation 5993 K
jcation 00.555 K

jcation 06,317 K

-

_

-

_




Langkah Keempat (4)

Klik Next untuk memulai Setup Wizard

E Mendeley Desktop Setup

|I=l| i:hr

Welcome to the Mendeley Deskiop
Setup Wizard

This wizard will guide you through the installation of
Mendeley Desktop.

It is recommended that yvou dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

LD Mext = | | Cancel
“‘.E.




Langkah Kelima (5)

Klik “I Agree” jika setuju dengan License Agreement yang diajukan

oleh Mendeley.

—E ] |

-
E Mendeley Desktop Setup l —1
License Agreement
Please review the license terms before installing Mendeley
Desktop.

Press Page Down to see the rest of the agreement.

:"-"IENDELE"I" PRIMCIFLES

q Our mission is to help you manage and share your research data as you choose, You
may wish to keep private your account profile details and what you are currenty
researching or reading, or you may wish to share your research activities or comments
with selected colleagues or the entire Mendeley community. ¥You decide what to share
and with whom.

We recognize that protecting user privacy and confidentiality is essential to open inguiry.
We are committed to respecting your privacy in your research. Please read this privacy
policy carefully to understand our practices regarding your personal data and how we
will treat it.

If you accept the terms of the agreement, dick I Agree to continue. ¥You must accept the
agreement to install Mendeley Desktop.

<Back | IAgreet\g | cancel |




Pembuatan akun mendeley selesai, selanjutnya akan ditampilkan
halaman dashboard pengguna seperti gambar di bawah ini:

3

M Feed Library Suggest Groups Datasets Careers Funding  Q Search L0 Hari@ v

FILTER BY .

Have you downloaded the Mendeley app?

| All posts

PUBLICATIONS On Desktop On Mobile
Citation updates

Recently published articles
Yyp M

Article suggestions

GROUPS

. £ Download an the GETITON
+ Joina group Download Desktop App « App Store )\" Google Play

Windows XP +




Langkah Keenam (6)
Klik Next untuk melanjutkan

-
Mendeley Desktop Setup

5 =

I
(Ifﬁme In=tall Location

Choose the folder in which to install Mendeley Desktop.

Browse and select another folder. Click Mext to continue.

1 Destination Folder

Setup will install Mendeley Desktop in the following folder. To install in a different folder, dick

Z:\Program Files (x8a)\Mendeley Deskio

Space required: 173. 7MB
Space available: 151.5G6

FMullsoft Install Swskem 2,51

Browse. .

< Back

][ Mext = ] [

Cancel ]




Langkah Ketujuh (7)

Klik Install untuk melanjutkan

- .
Mendeley Desktop Setup

Choose Start Menu Folder
Choose a Start Menu folder for the Mendeley Desktop shortcuts.

FMullsoft Install Swskem «2.51

=

e |

Select the Start Menu folder in which vou would like to create the program's shortouts., You
can also enter a name to create a new folder.

Accessories
Administrative Tools
Avira

Canon iP2700 series
Canon Uilites

Catalyst Control Center
Cisco Packet Tracer
Lames

Git

o Prograrmming Language
Google Chrome

11

[ Do not create shortouts

< Back

I

Install




Langkah Kedelapan (8)
Tunggu Proses Instalasi Selesai (100%)

-~

Mendeley Desktop Setup e l —_— | — |—"3'-r|

Lag”
In=tallimg
Flease wait while Mendeley Desktop is being installed.

Extract: Qt5Gui.dll
™

[ Show details ]

Mullsoft Install Swsktem w2.51

= Back Mext = Cancel




Langkah Kesembilan (9)

Klik Finish

E Mendeley Desktop Setup

||:||

[

LAs

Completing the Mendeley Deskiop
Setup Wizard

Mendeley Desktop has been installed on vour computer,

Click Finish to dose this wizard.

| Bun Mendeley Desktop

ack [ Finish ] Cance




Langkah Kesepuluh (10)

Pertama kali mendeley dijalankan akan meminta pengguna untuk
login, gunakan akun mendeley yang telah didaftarkan sebelumnya.

] Welcome to Mendeley Desktop I-ilj:—h.l

Welcome to Mendeley

E-rmail hari.aspriyon

Password sesssssss |

[] stay signed in




Langkah Kesebelas (11)
Setelah login berhasil, mendeley akan menyodorkan layar yang
menampilkan pilihan untuk install Plugin mendeley di Microsoft Word,

klik Install Now.
l Lrownieada I'U'IEI"IIZIEIE')" LJESICEIZIFI mmvar_e'mr

Mendeley Desktop

File Edit View Tools  Help
Hari @

[}

E - [::‘ E: " (T} -}
add Folders Welcome to Mendeley s I A Aty Sl o e s o S e

Mendeley
D Literature Search Reference Manager @ Citation Plugin for Microsoft Word®

Please close Microsoft Office® before trying to install Citation

BE.0 Donments Welcome to Mendeley!
') Recently Added To get started add your first document or ibrary (Endnote Plugin for Microsoft Word®. You can also install the Citation
Plugin from the Tools menu.

[ recently Read XML, BibTex, RIS or other).

My Library

1. Favorites
F, My Publications
Create Folder... Import documents or library b, Install now
Gronns

dq | 0 |

(Bselected

’Filter by Authors i
All

Discover Mendeley tools and tips to manage your references and citation styles.

([Z Read online help guides)

[7] Do not show me this message anymore

| 18% X Retrieving removed documents




Jika install plugin sukses, status,nya akan terlihat seperti gambar
di bawah ini:

k@ Citation Plugin for Microsoft Word®

v INSTALLED



Langkah Keduabelas (12)
Cek apakah di microsoft word sudah terdapat plugin mendeley.

Mailings Review View

1‘_‘) Undo

Eiﬂ Refresh B Open Mendeley

L Insert Bibliography

Insert
Citation * Export as = Style: |Harvard Referen... -

Mendeley Cite-O-Matic




N

Cara Menambahkan Referensi Ke
Aplikasi Mendeley

Menggunakan File PDF

Google Scholar
Secara Manual (Seperti Buku

dsb)



Memasukkan Referensi dari File PDF
ke Aplikasi Mendeley

S

MENDELEY

Memasukkan Referensi dari File PDF

PDF PDF

Sebagai perangkat lunak yang berfungsi sebagai reference
manager, mendeley memiliki fitur yang sangat bagus yaitu
pengguna dapat menambah referensi pada database mendeley
dari berbagai jenis diantaranya file PDF, Data Referensi Google
Scholar dan Referensi Manual seperti memasukkan referensi
buku dan sebagainya.



Langkah Pertama (1)

Siapkan File PDF berupa Artikel atau Karya llmiah lainnya.

Langkah Kedua (2)
Jalankan Mendeley Desktop, kemudian Klik Add > Add Files

-
Mendeley Desktop

Ty CIOTary
=l all Documnents
= Recently Added
|!_,_| Recently Read
1 Favoarites
_D_ My Publications
Create Folder...

GrOInS
4 | [}

m

Filter by Authors

All

L

(=[O e
File View Tools Help
(BT | = | [= a o @ .
Adgiles elated  Sync Help m
[ Add'Folder o _
Watch Felder — | = All Documents
Add Entry Manually % ® [ Authors Title Details Motes I Contents

No documents selected




Langkah Ketiga (3)
Pilih File PDF kemudian klik tombol Open

- ==

.- Add Files

@Qvl . ¥ Hari Asprij.ru-r;:l- » Downloads » Referensi - | +y | | Search Referensi Fe) |
—— e — —
=~ 0l @

Crganize - Mew folder

=l Libraries
@ Documents

d‘i Music

[E=| Pictures

B videos

Ll Computer
f &2 53A9797D002 (C3)
s DATA (D)

File name:

Date modified

Type

1

i Favorites = Mame 1
Bl Desktop | TH 2191-4289-1-5M ps/09/2018 1:36 Adobe Ac
4. Downloads SOOI TE 0&/09/2018 0:36 RIS File
=l Recent Places silabus-gis-msi \ 08,/09,/2018 0:52 Microsoft

- 4|

L

2191-4289-1-5M




Mendeley
+ Literature Search

My Library

2]l Al Documents
= Recently Added
|_L| Recently Read
[ Favarites

@ Meeds Review
‘q, My Publications
[ Unsarted

14 1L}

m

Langkah Keempat (4)
Klik pada Judul Artikel yang ditampilkan dan cek bagian Detail

= All Documents | Edit Settings

[Filter by Authors

Al
Kepahiang, 5 M K Megeri

* @ [ Authors

Title

P E Kepahiang, 5 M K Hegeri

IMPLEMENTASI SOFTWARE OPEN SOURCE DALAN
MEMBAMGUN INTRANET SEKOLAH MENENGAH KE!

Kepahiang, SM K
Megeri |

Detals | Notes | Contents |

@ These detais need reviewing. You can mark them as correct

or search the Mendeley catalog,

’De’mils are Currect] ’ Search ]

Type: | Journal Artide

IMPLEMENTASI SOFTWARE OPEN
SOURCE DALAM MEMBANGUN
INTRANET SEKOLAH MENENGAH
KEJURUAN

Authars: S, Kepahiang

A view research catalog entry for this paper

Journal:

Year: 2017
Volume: 2
Issue:

Pages:  83-100

Abstract:

L3

m

L]

Tane"




Dari gambar di atas, terlihat ada beberapa parameter yang tidak
sesuai, jika ditemukan masalah seperti ini, kita dapat memperbaikinya
dengan mengklik nilai parameter yang salah kemudian mengisi dengan
data yang benar kemudian klik Details are Correct.

Details MHNot=es I Contents

-@- These details need reviewing. You can mark them as caorrect,
or rch the Mendeley catalog.

||:3E'|Ei|5 are C-::-rre-::tl | Search |

M VI AN GO U g e
OorAH MEMNEMNMGAH
K) NEGERI 1

UL LY
TNTRANET
KEJURUAM (
KEPAHIAMNG

L. Asprivono, Har (Program Studi

Teknik Informatika, Fakultas Ilmu
Authors: Komputer, U. Arliando, yYode

(Program Studi Teknik Informatika,
] Fakultas IInému Komputer

1]

M| view research catalog entry for this paper

Journal: _IFKT _Tearrad Iricr Kosrrioorfer

Wear: 2017
YVaolume: =

T e = — .



Download Data Referensi Dari Google Scholar Untuk Menejemen
Referensi di Mendeley

aa

MENDELEY

Download Data Referensi dari Google Scholar

Google Cendekia
Komputas: awan a

Berdiri dl bahu raksasa




Google Scholar merupakan salah satu situs pengindek artikel
yang memiliki banyak fitur yang sangat membantu para
peneliti, penulis, dosen dan lainnya. Google Scholar juga
menyediakan fitur mengunduh file referensi yang dapat
digunakan untuk aplikasi managemen referensi.

File referensi tersebut akan menyediakan data-data seperti
judul penelitian/artikel, nama penulis, tahun terbit, lokasi
seminar, jumlah halaman, dan beberapa data lain-nya. Dengan
file tersebut, para penulis tidak perlu susah payah untuk
mengetik satu per satu informasi yang ada untuk dipindahkan
keaplikasi managemen referensi (cth: Mendeley Desktop,
JabRef, BibDesk, dll.)

Untuk mendownload data referensi dari Google Scholar dapat
dilakukan dengan beberapa langkah berikut:



Langkah Pertama (1)
Silahkan masuk ke laman https://scholar.google.co.id

Langkah Kedua (2)
Cari hasil penelitian dengan kata kunci (keyword) tertentu misal
"komputasi awan"

Google Cendekia
komputasi awan m

Berdiri di bahu raksasa

Google Scholar in English


https://scholar.google.co.id/

Langkah Ketiga (3)
Jika sudah ditemukan penelitian dengan kata kunci yang tepat, klik Cite
pada salah satu penelitian.

Analisis Sistem Penyimpanan Data Menggunakan Sistem Cloud Gomputing [POF] [ns.0rg
Stud Kasus SMK N 2 Karanganyar
TFajrn - LINSAonesian Joumal on Networking and Securty, 2012 - ns.org

enonjol dar komputasi awan adalan kemudahan akses .. National Insftute
and Technology (NIST), Infarmation Technolagy Laboratary membrkan
alan mengenal pangertian komputasi awan ..

i 99 Diruuk 18 kali - Artelterkalt Tversl 96

)

L] i 1 ™ i .



Langkah Keempat (4)
Setelah muncul jendela baru dengan berbagai format referensi, kita
dapat meng-klik teks “RefMan”. Jika berhasil, Anda akan mendapatkan
file yang bernama: “scholar.ris”.

Analisis Sistem Penyimpanan Data Menggunakan Sistem Cloud Computing [PDF] Ijns.org
Studi Kasus SMK N 2 Karanganyar

= AL

ra n - == fa

Yang paling mencnjol d % Kutip

of Standards and Technolc b
dua buah catatan mengen .
00 Diruiuk 18 ka MLA  Fajrin, Tina. "Analisis Sistem Penyimpanan Data Menggunakan

Sistem Cloud Computing Studi Kasus SMK N 2 Karanganyar.”
N S-Indonesian Journal on Networking and Security 1.1 (2012).

APA - Fajrin, T. (2012). Analisis Sistem Penyimpanan Data
Menggunakan Sistem Cloud Computing Studi Kasus SMK N 2
Karanganyar. [JNS-Indonesian Journal on Networking and
Securty, 1(1).

IS0 690 FAJRIN, Tina. Analisis Sister Penyimpa
Sistem Cloud Computing Studi Kasus
IUNS-Indonesian Journal on Netw

Data Menggunakan
N 2 Karanganyar.
and Security, 2012, 1.1.

BibTeX EndMote Reafilan RefWorks

.........



Langkah Kelima (5)
Simpan File "scholar.ris"

[ i Save As ﬁﬂ

ey,
@url . = Downloads » Referensi - | ¥f| | Search Referensi e |
Organize - Mew folder 4== = i
[ - .
<% Favorites Mame Date modified Type
Bl Desktop

Mo iterns match your search.
4. Downloads

L =
=) Recent Places

=4 Libraries
@ Documents

J”i Pusic
N [ Pictures p
¥ Videos L=l | T ’

File nam scholar -

Save as typ [HIS File (.ris) \ "r]
| :

- Hide Folders | save | | Cance |




Jika kita buka filenya menggunakan Notepad++ maka akan
terlihat seperti gambar di bawah ini:

| e oy o Y, e S
File Edit grch View Encoding Language Settings Tools Macro Run Plugins Window ? X
o LB 4BDcag 3 BESIEIROL® & EYEE|E
Elschoirss 3 |

1 TY - JOUR
2 Tl - Analisls Sistem Penyimpanan Data Menggr
3 Al - Fajrin, Tina
4 JO0 - IJNS-Indonesian Journal on Networking ¢
5 VL -1
6 IS -1
/SN - 2354-6654
8 YT - 2012
9 ER -
10
q T ,

Mormal text file length: 252 lines: 10 Ln:1 Col:1 Sel:0]0

Windows (CRLF)  UTF-8

INS




Memasukkan Referensi dari Google Scholar
Ke Aplikasi Mendeley

&N

MENDELEY

Memasukkan Referensi dari Google Scholar

Google Cendekia
a




Pertama (1)
Pastikan anda sudah Download Data Referensi Dari Google Scholar
Untuk Menejemen Referensi di Mendeley
Kedua (2) - Jalankan Aplikasi Mendeley Desktop
Ketiga (3) - Klik Add Files, kemudian cari file scholar.ris yang telah di
siapkan sebelumnya, kemudian klik Open

Mendeley De*op = R

PR = [& an £y @ Q ~ Search... Hari

-
Add Folders Related Sync  Help Add Files -]
Mendele - = -~ vl_ » Hari Aspriyono » Downloads » Referensi - | 4’-¢| | Search Referensi =)
¥ . — =l All Documen ul\\:/‘- = = : .
—' Literature Sear _
. - ® B Aut Organize MNew folder == ~ O @
My Lib -~
Y_|I rary L e @ Aspl - E = |~ Mame ¥ Date modified Type
=} All Documents £ = Yodi i Favorites %
© Recently Added M Desktop L 2191-4289-1-5M 08/09/2018 1:36 Adobe Ac
[ ] recently Read 4 Downloads |55 icon_pdf_png 08,09,2018 2:00 PMNG File
L Favorites i 1=l Recent Places | ] scholar.ris 08,/09,/2018 0:36 RIS File
® My Publications @< silabus-gis-msi 08/09/2018 0:52 Microsoft
[ Unsorted ol Libraries 3
Create Folder... i 5| Documents
P T — D J‘ Music
=] Pictures
[Filter by Authors S E Videos
All —
Arliando, Yode
Aspriyono, Hari '™ Computer
&, s3a0797D002 (C:)
o DATA (D) ~ 4| I b
File name: scholar.ris - [AII Files v]
‘ [ Open
4| [T 3 4 | T 3
h i 11}




Secara otomatis Aplikasi Mendeley akan mengambil data-data yang

Langkah Keempat (4)

ada pada file tersebut dan menampilkannya pada tab “Details” di
sebelah kanan.

f_" All Documents | Edit Settings

* ® [ Authors

Fajrin, Tina
L L h

¢ [ Aspriyono, Hari; Ariiando,
Yode

[I

Title

Analisis Sistem Penyimpanan Data Menggunakan
Cloud Computing Studi Kasus SMK N 2 Karanganys

IMPLEMEMTASI S0FTWARE OPEN SOURCE DALAR
MEMBANGUN INTRAMNET SEKOLAH MEMENGAH KE

Details | Motes | Contents |

Type: ’Jnurnal Article

Analisis Sistem Penyimpanan Data
Menggunakan Sistem Cloud

Computing Studi Kasus SMK N 2 K...

Authors: T, Fajrin

# View research catalog entry for this paper

DNS-Indonesian Journal on
Journal:

Networking and Security

Year: 2012
Volume: 1
[zsue: 1
Pages:

»

m




Memasukkan Referensi Secara Manual
Pada Aplikasi Mendeley

&N

MENDELEY

Memasukkan Referensi Manual

(Entry Manually)

Add Files

ted S
Add Folder =
Watch Folder

Add Entry Manually ;




Langkah Pertama (1)
Klik Add > Add Entry Manually

- e

Mendeley Desktop

File E lew Tools  Help
B E E | ® | &/l0
Add Files 'ielated Sync Help
- Add Folder i
Wt Folder ' “| 2 AllDocuments | Edit Settings |
Add Entry Manually % ® [ Authors
Py Torary L\\‘S’ B ® Fajrin, Tina




Langkah Kedua (2)
Pilih tipe referensi, pada contoh ini saya pilih "Book" untuk
memasukkan referensi berupa buku.

MNew Document

No Book Section h‘ b

Case
Authol Corputer Program =
Conference Proceedings
Journz Encydopedia Artide N

m




Langkah Ketiga (3)
Lengkapi informasi yang dibutuhkan seperti contoh gambar berikut ini:
(R MNew Docurment B | =S| ]

Type=: [E:c:--c:k. - il

Mudah Belajar Py thom uamtulbc
Aplikasi Desktop dam Wels

Aauthors: B. Rabhargi

TYear: 2015
FPages: S0
Abstracit:
Tags:

Aouathor ey woerd sz

L W

Eandumng

Edditiaer:

Editaoars:

Publis=her:
Imntformatk=s

-_

[ Reset ] ol [ Sove ) [ cancet |




Langkah Keempat (4)
Klik Save untuk menyimpan informasi referensi, dan Mendeley akan
menampilkan detil referensi.

=] All Documents Edit Settings

* ® [ Authors Title Details | Notes | Contents |
® F‘.aharl'ﬁI Budi Mudah Belajar Python Untuk Aplikasi Desktop dan

Type: [Bnuk w7 ] 7
® Fajrin, Tina Analisis Sistem Penyimpanan Data Menggunakan § | Mudah Belajar Python Untuk Aplikasi
Cloud Computing Studi Kasus SME M 2 Karanganys [}Eﬁktﬂp dan Web
. Aspriyono, Hari; Arliando 1, — . RCE DALAN
[} E r i r . cie Sie 'y
= vode mg Analisis Sistem Penyimpanan

ENGAHKE|| Authors: B. Raharjo
Data Menggunakan Sistern ]

Ca Cotnn S ks # view research catalog entry for this paper
SMEK M 2 Karanganyar —

Year: 2015
Pages: 319-334

Abstract:

Tags:

Author Keywords:

City:
Bandung

Edition:

4 L




Mengutip Referensi Karya limiah dengan
Microsoft Word dan Aplikasi Mendeley

Mengutip referensi pada sebuah karya ilmiah tentu
merupakan hal yang sangat penting. Bahkan beberapa
lembaga memiliki standar atau aturan yang mengatur
cara pengutipan dan juga pembuatan daftar pustaka.
Misalnya dalam membuat proposal penelitian, skripsi,
tesis, disertasi atau artikel ilmiah yang akan diterbitkan
pada jurnal ilmiah.

Berikut ini adalah langkah demi langkah untuk mengutip
referensi pada Microsoft Word dengan Aplikasi
Mendeley:



Langkah Pertama (1)
Pastikan Microsoft Word sudah terinstall “Plugin Mendeley” dari
Aplikasi Mendeley Desktop

References Mailings Review View

1:) Undo

L Insert Biblicgraphy
ey

tnote - réﬂefresh B Open Mendeley
Insert
tes Citation *+ Exportas~ Style: Amencan Psych.., -~
M= Mendeley Cite-O-Matic



Langkah Kedua (2)
Posisikan kursor pada teks yang akan direferensi

LANDASAN TEORI

2.1 Tentang Satu

Lorem 1psum dolor sit amet, consectetur adipisicing elit, sed do etusmod tempor
incididunt ut jabore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
e}:ercfratmn larﬂc::: laboris fis1 ut ahqmp ex ea commaodo cc:-ﬂsequat Dms aute trure dolor




Langkah Ketiga (3)
Klik Pada Tab References > klik Insert Citation, kemudian ikuti langkah
pada gambar di bawah ini

LATIHAM MGETIK - Word
Reference Mailings Review View @ Tell me what you want to do...
ndnote + D Undo L Insert Bibliography @ = Manage Sources [] Insert Table of Figures D 2 Ins
M —
wotnote - Ef,u Refresh B Open Mendeley [% Style: APA v Update Table Up
Insert Insert | Insert Mark
lotes ’Citation +- Export as = Style: Amj%:an Psych.. ~|| Citation - EDEthingraph}r* Caption El._:| Cross-reference Entry
P Pendeley Cite-C-Mati Citations & Bibliography Captions Inde
|-2|-1-|- 'Iel'll\;‘:{'l']'l'4'I'5'I'l5-'l'?'I'ﬂ'l'g'l'lﬂ'l'11'I'11'I'13'I'14'I'15'I'|/_\I'I'l?'l'm'
3
ot implementasi 4
IMPLEMENTASI SOFTWARE OPEN SOURCE DALA BANGUN INTRANE
2.1 Tentang Satu Hari Aspriyono: ¥ Arliando - 2017 - JIK: Jurnal Iimu Komputer
Lorem 1p |
incididunt ut lal |
exercitation ullail |
in reprehendert |
sint occascat cujl |
laborum. { 5
[My Library "’] [ Go To Mendeley] [ oK ] [ Cancel ] |
No - |
1

2 120 Seratus Tiga Puluh




Sehingga tampilan pada dokumen menjadi seperti pada gambar
berikut ini:

2.1 Tentang Satu

Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip x ea commodo consequat. Duis aute irure dolor
in reprehenderit m:l;'ﬂluptate velit esse cillum dolore eu fugiat nulla panatur. Excepteur

sint occaecat cupidatat non proident. sunt in culpa qui officia deserunt mollit anim 1d est
labﬂﬂun.I{Asprij,-':}n:} & Arliando, 201 ?j’l

Tabel 2.1 Tabel Nilai

No Nilai Keterangan
1 1100 Seratnc
Catatan ;

Ulangi langkah 2 dan 3 untuk mengutip atau menambah
referensi yang lain pada dokumen anda.



Langkah Keempat (4)
Referensi akan secara otomatis muncul berdasarkan “Style” referensi
yang dipilih. Jika menginginkan untuk merubah style silahkan pilih style
seperti pada gambar berikut:
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Dalam memilih style pastikan style yang dipilih
adalah style yang sesuai dengan aturan yang
telah ditetapkan pada karya ilmiah, Misalkan
IEEE, dan lain sebagainya. Selanjutnya semua
referensi yang telah dikutip dicantumkan pada
daftar pustaka dengan Cara Membuat Daftar
Pustaka Secara Otomatis pada Microsoft Word
dengan Mendeley.



Membuat Daftar Pustaka Secara Otomatis pada
Microsoft Word dengan Mendeley

MENDELEY

Membuat Daftar Pustaka Secara Otomatis

DAFTAR PUSTAKA

Asprivono, H., & Arliando, Y. (2017). IMPLEMENTASI SOFTWARE OPEN SOURCE
DALAM MEMBANGUN INTRANET SEKOLAH MENENGAH KEJURUAN (SMK)
JIK: Jurnal Iimu Komputer, 2, 88—-100.

Febrian, J. (2004). Pengetahuan Komputer dan Teknologi Informasi. Bandung: Informatika.

Oktavian, D. P. (2010). Menjadi Programmer Jempoian Menggunakan PHP. Yogyakarta:
MediaKom.




Langkah Pertama (1)
Buat halaman Daftar Pustaka dan Berikan Judul "DAFTAR PUSTAKA"
seperti contoh pada gambar berikut ini:

TR R R TR SRS T R ST (T ST U S SRS SIS SR AT SRR ST T ST BRES L SR T § ACI B AR BRI &= OB BRI T SRR AT LSRN SRR ORI I AR I F:

DAFTAR PUSTAKA



Langkah Kedua (2)
Posisikan kursor anda sebagai awal penempatan daftar pustaka,
kemudian klik References > Insert Bibliography pada Plugin Mendeley
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Secara otomatis daftar pustaka akan tercipta seperti contoh pada
gambar berikut ini:

DAFTAR PUSTAKA

Asprivono, H.. & Arliando, ¥ _(2017). IMPLEMENTASI SOFTWARE OPEN SOUERCE
DATLAM MEMBANGUN INTEANET SEKOLAH MENENGAH KEJTURUAN (SMEK)
SR Jurnal Hmu Komputer, 2, B8—100.

Febrian_  J. (2004). Pengerahuan Komputer dan Telmologi Informasi. Bandung: Enfoimatika_

Oktavian, D P. (2010). Merjadi Programmer Jempolan Mengounakan FHF. Yogyvakarta:
MediaKom.

Yuhefizar. (2008). Database Management Mengounakan Microsoft Access 2003, Jakarta: PT.
Elexmedia Komputindo.




Langkah Ketiga (3)
jika ingin merubah style, anda dapat melakukannya dengan memilih
style yang tersedia pada plugin Mendeley.

ote - E,H Refresh &= Open Mendeley [% Style: |Harvard - Update Ta
Insert Insert Insert
Citation * Exportas~ Stylee American Psych., Citation = E 1 Bibliography - Caption E|I_I| Cross-refe
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Selamat
Menggunakan Software Mendeley
Untuk Menyelesaikan Tulisan Anda

Dan
Manajemen Referensi

Wassalam



